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EXCEL

Spreadsheet 

Is a grid of rows and columns used for manipulating numbers and doing calculations. 

It is also called a worksheet.

Spreadsheet application programs 

Programs used for automating task like calculations, statistics, analyzing data and graphical representation of numerical data.

Workbook

A workbook usually contains several worksheets in which you work and store data. Each excel workbook consists of a maximum of 255 worksheets. By default, a workbook displaces only 3 worksheets.

Worksheet

A worksheet consists of cells that are organized in grid format (columns and rows). 

There are 65,536 rows and 256 columns in one worksheet.

The intersection of a row and a column is called a cell.

Cell
A cell is a place where columns and rows intersect. Each cell has an address based on its column letter and row number. If you’re in cell A1 means you’re in column A, row 1. An active cell is a cell that is highlighted and can be edited.

Labels

Cell entries that include letters, combination of numbers and letters, and symbols are termed as labels. Labels entries in the cells are aligned to left by default. Labels entries can not be used for calculations.

Values

Cell entries that include numbers that can be used for calculation are termed as values. Value entries in the cells are aligned to right by default.

Functions

Functions are predefined formulas. Functions can be a more efficient way of performing mathematical operations than formulas. 

A formula is an equation that calculates a value for a cell or a range of cells. You enter a formula into the formula bar preceded by an equal (=) sign.

For example, if you wanted to add the values of cells D1 through D10, you would type the formula "=D1+D2+D3+D4+D5+D6+D7+D8+D9+D10". A shorter way would be to use the SUM function and simply type "=SUM (D1:D10)". Several other functions and examples are given in the table below:

	Function
	Example
	Description

	SUM
	=SUM (A1: A100)
	Finds the sum of cells A1 through A100

	AVERAGE
	=AVERAGE (B1:B10)
	Finds the average of cells B1 through B10

	MAX
	=MAX (C1:C100)
	Returns the highest number from cells C1 through C100

	MIN
	=MIN (D1:D100)
	Returns the lowest number from cells D1 through D100

	COUNT
	=COUNT(A1:A9)
	Count the number of cell that contain number

	COUNTIF
	=COUNTIF(A1:A9)
	Count the number of cells within a range that meet the given condition. 

	COUNTA
	=COUNTA(A1:A9)
	Count the number of cells that are not empty.


IF Functions

The IF function will check the logical condition of a statement and return one value if true and a different value if false 

The syntax is 

· =IF (condition, value-if-true, value-if-false)

· Value returned may be either a number or text 

· If value returned is text, it must be in quotes
Formula

A formula is an equation that performs operations on worksheet data. Formula can be up to 255 characters long. A formula must always begin with an ‘=’, ‘+’, or a ‘-‘sign. 
Calculation operators in Formulas

Operators specify the type of calculation that you want to perform on the elements of a formula. Microsoft Excel includes four different types of calculation operators: arithmetic, comparison, text, and reference.

Arithmetic operators:
	Operator
	Meaning
	Example

	+
	Addition
	3+3

	–
	Subtraction
Negation
	3–1
–1

	*
	Multiplication
	3*3

	/
	Division
	3/3

	%
	Percent
	20%

	^
	Exponentiation
	3^2 (the same as 3*3)


Comparison operators:

	Operator
	Meaning
	Example

	=
	Equal to
	A1=B1

	>
	Greater than
	A1>B1

	<
	Less than
	A1<B1

	>=
	Greater than or equal to
	A1>=B1

	<=
	Less than or equal to
	A1<=B1

	<>
	Not equal to
	A1<>B1


Text operator:

	Operator
	Meaning
	Example

	&
	Connects, or concatenates, two values to produce one continuous text value
	"North" & "wind" produce "Northwind"


Reference operators:

	Operator
	Meaning
	Example

	:
	Range operator, which produces one reference to all the cells between two references, including the two references
	=Sum(B5:B15)

	,
	Union operator, which combines multiple references into one reference
	=SUM(B5:B15,D5:D15)


Order of Evaluation of Operators

Excel evaluates a formula in a particular order determined by the precedence number of the operators being used and the parentheses placed in the formula.

Note: Operators inside the Parentheses are evaluated first.
	Operator
	Description
	

	:
	Range of cells
	

	Space
	Intersection of cells
	

	,
	Union of cells
	

	-
	Negation
	

	%
	Percentage
	

	^
	Exponentiation
	

	*
	Multiplication
	

	/
	Division
	

	+
	Addition
	

	-
	Subtraction
	

	&
	Concatenation
	

	=
	Equal to
	

	<
	Lesser than
	

	>
	Greater than
	

	<=
	Lesser than or equal to
	

	>=
	Greater than or equal to
	

	<>
	Not equal to
	


Header and Footer

· Add preset headers and footers to the page by clicking the drop-down menus under the Header/Footer tab.
View -> Header and Footer
Charts

Charts enable you to present worksheet data in graphical form. 

Elements of a Chart

In Excel you can have either 2-D or 3-D charts. The elements of a 2-D chart are: -

Y-Axis

Y-Axis is called as the series axis. It shows the value of data points that are plotted.
X-Axis

X-Axis is known as the category axis, shows the categories of the data points that are plotted.
Category names

Category names identify the individual data points. The category names are taken from the topmost row or the left-most column, depending on the orientation of the sheet.

Legends

Legends are markers or symbols that represent the set of tables that describe the data series.  It is used to differentiate one set of data from another. If your chart does not include a legend, you can easily add one. You also can format a legend with border, pattern, and font selections.

Data marker
Data marker is another tool used to differentiate one data series from another.

Tick marks
Tick marks are small lines used to divide the two axis and provide scaling.

Gridlines

Gridlines are displayed for both axis to help read the value of individual data points. Gridlines are scaled according to the values on the axis and can be changed.
Data labels

Data labels are displayed at times to show the value of data points. Data labels can represent the value for that data point or the category axis label associated with the data point. 

Selected Border

Selected Border identifies that a particular chart can be sized, moved or deleted and contains nodes or handles for that purpose.
Types of  Charts:

[image: image16.jpg]Some of the most commonly used charts are described below: 
Column chart
Illustrates individual values at a specific point in time and is suitable for almost any data type, particularly side-by-side comparisons of numerous data values. This type of chart is used for displaying discrete data.
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Bar chart
Same as a column chart, but displays bars horizontally rather than vertically. 
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Line chart

Illustrate linear or unbroken changes in a large number of values. 
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Pie chart

A pie chart is useful when we want to show relative proportions or contributions with 

respect to a whole entity. Shows the relationship of parts to the whole and to each 

other, so that the reader can assess and compare items readily. 
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XY (scatter) chart
Plots two group of numbers as one series of XY coordinates. Useful as a diagnostic 

tool when looking for heavy occurrences or absences of data. Commonly used

for scientific applications. 
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Area chart
Shows how volume changes over time and emphasizes the amount of change. Useful for 

giving a bigger sense of "mass" of a change or concept. 
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Stock Charts

Stock Charts are very useful for displaying stock market information. This chart 

requires three to five data series, depending on the sub type. This chart uses the 

High-Low-Close subtype that requires three data series

Sort

To arrange the data in certain order. Ascending order means arrange a number from smallest to largest. Descending order means arrange a number from largest to smallest.

AutoFilter

AutoFilter selects and shows you only the data you want to see.

ACCESS
Exploring the Access Interface

Besides the usual window components (close box, title bar, scroll bars, etc.), an Access window has several unique elements identified in the figure below. 
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Access

Access is a relational database management system (RDBMS).  It can be used as a flat-file database (using a single table) or a relational database (using more than one table linked together).  Access database applications can be created for a large number of database situations including financial and scientific data - with excellent results.  The disadvantage to using Access is that it is a difficult package to learn.  
Database Components

An Access database consists of seven different components. These are: tables, queries, forms, reports, pages, macros, and modules. Use the buttons in the database window shown below to create and modify these components. Each component listed is called an object. 
Database

A database is a collection of related tables. It can also include other objects such as queries, forms, and reports. The structure of a database is defined by the relationships which exist between all of its tables. 
Table

A table is a collection of related records. For example, tables for employees, products, customers, or orders. 

In a table, records are represented as rows and fields are represented as columns. 
Field

A field is an area (within a record) reserved for a specific type of data. Examples: customer number, customer name, street address, city, state, phone, current balance. 

To define a field in a DBMS, we must specify: 

· Field name 

· Data type:- 

· Character: text, including such things as telephone numbers and zip codes 

· Numeric: numbers which can be manipulated using math operators 

· Date: calendar dates which can be manipulated mathematically 

· Logical: True or False, Yes or No 

· Field size 

· Amount of space reserved for storing data 

Record

A record is the collection of the contents of all fields which pertain to one entity: i.e. a person, product, company, transaction, etc. 
Primary key

A Primary key is a field (or combination of two or more fields) in a table that uniquely identifies every record in that table. 

The primary key is an important aspect of a relational database.  The primary key is an index where no duplicates and no blank fields are allowed, i.e. it must be unique to a particular record.  

The primary key doesn't have to be a single field.  It can be formed from several fields whose values together uniquely identify a single record.  There can be only one primary key index per table.  The primary key is particularly important when creating relationships between tables.
Foreign key

When a "One" table's Primary key is added to a second, or "Many" table to create the common field which relates the two tables, it is called a foreign key in the second table. 

In the example above, the Primary key (customer number) from the Customer table (the "One" table) is a Foreign key in the Orders table (the "Many" table). 

The Foreign key identifies which unique record in the Customer table is associated with the "Many" records of the Orders table. 
Relationships

In a relational database, you can take data from more than one table at the same time and display it in a form, query or report.  If you want Access to automatically relate data between two tables you must first create a relationship between them.  To create a relationship there must be a common field between the two tables.  

There are three kinds of relationships which can exist between two tables: 

· One-to-One 

· One-to-Many 

· Many-to-Many 

The most common relationships in relational databases are One-to-Many and Many-to-Many. 
One-to-many relationships

The most common relationship is one-to-many where each record in a table can be associated with many records in another table.  So each primary key value can appear many times in the related table as the foreign key.  (The primary key is a unique value appearing only once in the 'One' table)
One-to-one relationships

In a one-to-one relationship, each record in the primary table can be associated with only one record in the related table.  In this case the related fields must be the primary keys of both tables.  

Indexes

Creating indexes allows Access to query and sort records faster. To set an indexed field, select a field that is commonly searched and change the Indexed property to Yes (Duplicates OK) if multiple entries of the same data value are allowed or Yes (No Duplicates) to prevent duplicates.
Field Validation Rules

Validation Rules specify requirements (change word) for the data entered in the worksheet. A customized message can be displayed to the user when data that violates the rule setting is entered. Click the expression builder ("...") button at the end of the Validation Rule box to write the validation rule. Examples of field validation rules include <> 0 to not allow zero values in the record, and ??? to only all data strings three characters in length.
Example:

· LIKE “###”

· LIKE “MM###”

· <> 0
Input Masks

An input mask controls the value of a record and sets it in a specific format or pattern. They are similar to the Format property, but instead display the format on the datasheet before the data is entered. For example, a telephone number field can formatted with an input mask to accept ten digits that are automatically formatted as "(555) 123-4567". The blank field would look like (___) ___-____. An an input mask to a field by following these steps:

· In design view, place the cursor in the field that the input mask will be applied to. 

· Click in the white space following Input Mask under the General tab. 

Click the "..." button to use the wizard or enter the mask, (@@@) @@@-@@@@, into the field provided.
Table design

	The Sections of table design

	Field name
	identifies the data stored in a field. The field name can be up to 64 characters long. The maximum number of fields per record is 255

	Data type
	tells Access what kind of data goes in the field, for example, text, numbers, dates

	Description
	allows you to describe the purpose of the field - shown at the bottom of the screen as an Enter field

	Field properties
	provide parameters and formatting for each field


	Data Types

	Text
	255 character maximum

	Memo
	64,000 character maximum

	Number
	integer, decimal and floating point

	Date/Time
	100 AD to 9999 AD. Date formats can be found under Help on Date fields/Data display formats, select Format, then click on Date/Time data type.

	Currency
	accurate to 15 digits on left, 4 digits on right

	Autonumber
	a numeric value that Access automatically increments for each record you add

	Yes/No
	logical.

	Hyperlink
	Web address, link to a MSOffice object, Access object etc (max 2048 char)

	OLE Object
	object, Linking & Embedding objects (for example, graphics, sound, MSOffice object - up to 1 Gigabyte), not Web address


	Field Properties

	Field Size
	limits length of field

	Format
	format of dates and numbers

	Decimal Places
	available for Number/Currency field

	Caption
	specify a label other than field name for Forms and Reports

	Default Value
	automatically fills in a value in new records

	Validation Rule/Text
	limits the data which can be entered

	Indexed
	speeds up searches


	Formats for Number Fields

	Byte
	0 to 255
	No decimals (no negatives)

	Integer
	(32,768
	No decimals

	Long Integer
	(2,147,483,648
	No decimals

	Single
	(3.4 x 1038
	7 decimal places

	Double 
	(1.797 x 10308
	15 decimal places


Formats - You can specify formats for number, currency, date/time and Yes/No data types.  If you do not like the built-in formats you can use format symbols to specify any type you want.  For example:

	>
	force text display to upper case

	<
	force text display to lower case

	mmm yyyy
	display date in format Jan 2002


Introduction to Queries

A query is a request you present to the database, and the database displays its response to you. The whole purpose of creating a query lies on how you formulate that request. 

Queries enable you to find, sort and change data according to specified criteria.  They also enable you to combine data from different tables into a single query and use functions and expressions.

Queries are used to ask questions to find specific information so that only some of the records (and/or some of the fields) are extracted.  

Views in the Query Window
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The query window has four views: Design View, Datasheet View, SQL View, and Print Preview. In Design View you can create and modify the design of a new or existing query, using graphical tools. In Datasheet View, you see the data retrieved by your query in a spreadsheet-like format. If you know Structured Query Language (SQL), SQL View allows you to examine and modify the statements that underlie your query. In Print Preview you see how your query data will look in print.
Creating Queries

Queries allow the user to search data from a table(s) and then save that search. Criteria can be specified and saved in a query. There are several types of queries which perform several types of tasks. A select query is a standard query. To create a simple select query, use the Simple Query Wizard. 

Criteria for Queries

	Condition
	What it Does 
	Example

	=
	Exactly matches
	=100, =smith

	<
	Less than 
	<100

	<=
	Less than or equal to 
	<=100

	>
	Greater than 
	>100

	>=
	Greater than or equal to 
	>= 100 

	<>
	Not equal to 
	<>100, <>Texas

	Is Null 
	Empty field
	 

	Between X and Y 
	Between one word or number and another word or number 
	 

	*
	Wildcard character 
	Smi* finds words that begin with Smi such as Smith and Smithsonian 




Using Wildcards

When searching for data, you may want to search for a range of text values or you may not have the exact spelling of a word.  The most useful wildcards are described below.  

Among the most popular string operators you can use, the wildcards present themselves as perhaps the most valuable tools you will encounter. If you want to select records that contain certain patterns of characters or cannot remember an exact data entry, use the wildcards (* and?) in your search. The question mark (?) stands for any single character, while the asterisk (*) stands for any number of characters in the same position. 

	Character
	Meaning
	Example

	?
	Matches one character
	B?t would find Bat, But, Bet, but not Boat etc

	*
	Matches any number of characters
	B*t would find Bat, Boat, Bracket etc

	#
	Matches a single digit  in a text field
	3#5 would find 375, 385 etc

#05 would find 105, 205 etc


Forms and Reports

Forms

· Form is another way to view, add, delete or modify data in Access table. However, using a form allow you to enter data based on the arrangement of your preference.

· When you want to display data in the form, a record source like table or query is needed.

· The objects used to label and display data on the form are called Controls.

· Examples of control are checkbox, textbox, list box, combo box, label, command button etc.

· The toolbar used to add this control is called Toolbox (see figure 1 below)
· Some of the controls are label, textbox, command button, option box, image, check box etc

[image: image3.png]Acabl[M 2 60~ BlE o @RS




Figure 1

· The controls on the form can be formatted using the formatting toolbar. Some of the formatting you can used are fore/font color, font type, font size, alignment, Fill/Back color, line/border color, line/border width, special effect such as sunken, raised or etched.

There are five sections in a form as in figure 2 below
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Figure 2
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A form header displays information that remains the same for every record, such as a title for the form. A form header appears at the top of the screen in Form view (Form view: A window that displays a form to show or accept data. Form view is the primary means of adding and modifying data in tables. You can also change the design of a form in this view.) and at the top of the first page when printed.

[image: image6.png]


A page header displays information such as a title or column headings at the top of every printed page. Page headers appear only on printed forms.
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A detail section displays records. You can either display one record on the screen or page, or display as many as will fit.
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A page footer displays information such as the date or page number at the bottom of every printed page. Page footers appear only on printed forms.
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A form footer displays information that remains the same for every record, such as command buttons (command button: A control that runs a macro, calls a Visual Basic function, or runs an event procedure. This is sometimes called a push button in other applications.) or instructions for using the form. A form footer appears at the bottom of the screen in Form view or after the last detail section on the last page when printed.

There are 3 ways to create a form

· Using Autoform

· Using Wizard

· Using your own design in design view

Creating a Form with form wizard

· The form wizard is a powerful tool that can quickly make data-entry form for the user. 

· The form wizard will:

· Prompt you to select a table or query as the form’s record source.

· Prompt you to select the layout:

· Columnar
- display controls in columns and useful if the record source has many tables. 

· Tabular – display controls in rows in the form and useful if the field is few and you want to display more than one record at a time.

· Datasheet – display the form in datasheet view and commonly used with sub form

· Justified – display in uniform size

· Prompt you to select style using access template

· Prompt you for the name of the form

· Prompt you to select the way to view the form.

· There are three ways to view a form.

1. Design view 

a. User can set properties for the form

b. User can modify a form’s appearance

2. Form view

a. Lets the user view, add, delete and modify data 

3. Datasheet view

a. Display the contents of the form in a spreadsheet-like format.

Navigating through record

Records in the form can be navigated through 2 ways:

1. Through record navigation buttons which are located in the lower left corner of a form.

2. Through Find command, located on the Edit menu by typing the keywords.

Note: You can also use the command button created using the control in the toolbox.

Reports

· Report is used to quickly view data from a table or a query. You can preview a report or print it out.

· Report design is similar to form design and you may use controls from the toolbox to design the report.

There are 7 sections in the report

· Report Header

· Page Header

· Group Header

· Details

· Group Footer

· Page Footer

· Report Footer

There are three ways to view a report

1. Design view – create and modify report

2. Print Preview – see onscreen what the report will look like on printed page.

3. Layout Preview – shows abbreviated version of the report and useful for previewing a large report.

Creating a Report with report wizard

The report wizard will ask you a few questions that you must answer such as:

· The data source? Table or query

· The fields you want to see in the report

· The grouping you will use in the report.

· If the report has numeric data, report wizard will add summary options button to the sort screen. Summary options include sum, average, min and max.

· The fields you are going to sort and type of sorting

· The layout

· Columnar – use this if tables or queries contain many fields.

· Tabular – lets you show multiple records on a page.

· Justified – give the controls on the form a uniform appearance.

· When grouping is added to the report, more layout is available:

· Stepped

· Block

· Outline 1

· Outline 2

· Align left 1

· Align left 2

· The style – you can use the report template

· The title for the report

Changing the margins to fit more data per page

Sometimes you have to change margin to fit the data in the page either horizontally or vertically. You can change this using page setup.

Additional information on forms and reports

Add or remove a form or report section

Form headers and footers appear at the top and bottom of a form in Form view (Form view: A window that displays a form to show or accept data. Form view is the primary means of adding and modifying data in tables. You can also change the design of a form in this view.) and at the beginning and end of a printed form. Report headers (report header: A report section that is used to place information (such as a title, date, or report introduction) at the beginning of a report.) and footers (report footer: A report section that is used to place information that normally appears at the bottom of the page, such as page numbers, dates, and sums.) appear at the beginning and end of a printed report. Page headers (page header: Used to display a title, column headings, dates, or page numbers at the top of every page in a form or report. In a form, the page header appears only when you print the form.) and footers (page footer: Used to display page summaries, dates, or page numbers at the bottom of every page in a form or report. In a form, the page footer appears only when you print the form.) appear at the top and bottom of each printed page— they don't appear in Form view.

1. Open a form or report in Design view (Design view: A window that shows the design of these database objects: tables, queries, forms, reports, macros, and data access pages. In Design view, you can create new database objects and modify the design of existing ones.). 

2. Do one or more of the following: 

· To add or remove form header and footer, click Form Header/Footer on the View menu. 

· To add or remove report header and footer, click Report Header/Footer on the View menu. 

· To add or remove page header and footer on a form or report, click Page Header/Footer on the View menu. 

· To add or remove group header (group header: Used to place information, such as group name or group total, at the beginning of a group of records.) or footer (group footer: Used to place information, such as group name or group total, at the end of a group of records.) on a report, do the following: 

1. Click Sorting and Grouping [image: image10.png]


on the toolbar. 

2. In the Sorting and Grouping dialog box, click a row in the Field/Expression column. 

3. To hide the group header section, in the lower portion of the dialog box, set the Group Header property to No. 

4. To hide the group footer section, set the Group Footer property to No. 
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Resize a form or report section

You can increase or decrease the height of form and report sections (section: A part of a form, report, or data access page such as a header, footer, or detail section.) individually. However, when you change the width of one section, you change the width of the entire form or report.

1. Open the form or report in Design view (Design view: A window that shows the design of these database objects: tables, queries, forms, reports, macros, and data access pages. In Design view, you can create new database objects and modify the design of existing ones.). 

2. Do one or more of the following: 

To change the height of a section, place the pointer on the bottom edge of the section and drag the pointer up or down.
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To change the width of a section, place the pointer on the right edge of the section and drag the pointer left or right.
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To change both height and width of a section, place the pointer in the lower-right corner of the section and drag it diagonally in any direction.
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